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Excel is a powerful application for organizing, manipulating, and analyzing data. It is an essential tool in many work and academic environments, and can be used for managing personal information. Just a few examples of common uses include:
1. Budget preparation and monitoring
2. Tracking inventory
3. Tabulating and analyzing survey data
4. Maintaining contact lists
I often advise my trainees to use Excel for anything that involves crunching numbers or making lists. While it is possible to do these things in Word, Excel is more flexible and powerful for performing these tasks. 
While reading this chapter (as well as when working in Excel), you should set your screen reader punctuation level at most or all. Setting it at some or none will fail to detect a number of punctuation marks like parentheses, colons, and a few more that are important in the syntax for creating formulas. To change punctuation levels for the three screen readers, see Chapter 8.1.1 for JAWS, 8.2.2 for NVDA, and 8.3.1 for Narrator.
5.1 The Basics
5.1.1 Terminology
A spreadsheet is a document that stores data in a grid of horizontal rows and vertical columns. Rows are usually labeled using numbers (1, 2, 3, etc.), while columns are usually labeled with letters (A, B, C, etc.). Individual row/column locations, such as C3 or B12, are referred to as cells, and each has a cell coordinate. For example, cell A3 is located in the first column and third row, cell E10 is located in the fifth column and tenth row, and so on. “Spreadsheet” is a generic term for any such document or file, including, but not limited to Excel. 
An Excel file is called a workbook and may be composed of anywhere from one to a large number of sheets or worksheets. Think of a sheet as a page.
Until you rename them, they are assigned the generic names “Sheet1, Sheet2, Sheet3, etc.” Worksheets are where information is entered and manipulated in a workbook. 
When you first open a new blank Excel file, and press Insert T to hear its title, you will hear “Book1, Sheet 1, A1.” 
A blank spreadsheet is a vast area with thousands of columns and over one million rows. Columns and rows are labelled with letters and numbers, respectively. A cell reference or cell coordinate is expressed as its letter and number combination. For example, cell A1 is located in the first column and first row, cell C5 is located in the third column and fifth row, and so on. A “data range” refers to a group of contiguous cells. For example, the data range from B2 through B9 refers to the cells containing B2, B9 and all the cells in between in this column. A data range can also be a rectangular block of cells. The data range of B2 through F9 includes the rectangular block of cells with B2 located at the top left, B9 at the bottom left, F2 at the top right, and F9 at the bottom right. 
Three types of data can be entered in cells: text, numbers, or formulas. Numbers may be expressed as simple numbers, currency, dates, percentages, or in several other formats. Formulas are calculations referencing cell references or numbers from elsewhere on the spreadsheet. For example, if numbers are contained in columns A and B, a formula can be typed in column C to total the numbers in the respective rows of columns A and B. However, in composing the formula, you would usually not type in the actual numbers in those cells, but rather the corresponding cell coordinates. 
Formulas can be very simple or quite complex. More on formulas below. 
5.1.2 entering Data and Navigating Spreadsheets
Use the arrow keys to move one cell at a time among the column’s and rows of the spreadsheet. The Up and Down arrows move up and down columns. The left and Right arrows move across rows. 
After typing data in a cell, pressing any of the arrow keys will conserve that data in the cell and move the cursor focus to the next cell in the direction that you just arrowed. You can also press the Tab key to move one cell to the right, equivalent to pressing the Right arrow key. In addition, pressing the Enter key will conserve the data and move the cursor one cell below. If you type in data and press the Escape key, none of the data you just typed will be conserved. If you sense that you have made a typing error, immediately press the Escape key to prevent replacing correct data with the mistaken keystroke. Failing to do this is a common frustration for beginners. 
From anywhere on a spreadsheet, pressing Control Home moves the cursor focus to cell A1, the top left corner of the spreadsheet. Pressing Control End places the cursor focus on the cell that is the intersection of the right-most column with at least one cell containing data, and the bottom-most row with at least one cell containing data. For example, if the right-most cell with data is F32 and the bottom-most cell with data is A 47, pressing Control End will place cursor focus on cell F47. This keystroke is especially useful for exploring a spreadsheet that you did not prepare yourself. If pressing Control End lands the cursor in cell F47, you know that all data in the sheet are located between A1 and F47. There are no data to the right of column F, nor below row 47. 
While using the four arrow keys to navigate one cell at a time is useful for navigating in small areas, you can navigate quickly over large blocks of filled and unfilled cells by pressing the Control key in combination with the four arrow keys. This is referred to as “navigating by region.” A region is a range of cells that contain data and are bordered by blank cells. It is synonymous with a data range. 
5.1.3 Simple Formulas
There are three categories of formulas:
· Those containing operators which are the keys for adding, subtracting, multiplying, and dividing data from two or more specified cells.
· Those containing functions for making calculations over a range of data. 
· And those containing a combination of operators and functions.
Let’s begin by typing the numbers 1000 in cell A1 and 250 in cell A2. Don’t type in a comma separator in 1000. Under this data, we will input several of the simplest and most common formulas. 
All formulas begin with the equal sign, signaling to Excel that a formula is being entered in the cell. The equal sign is located two keys to the right of the zero key on the number row of your keyboard. When you type the equal sign, your screen reader will say “type in a formula and press Enter.” We will start with simple formulas using operators for adding, subtracting, multiplying, and dividing two numbers. 
1. Addition: In cell A3, type in “=A1+A2,” minus the quotes, and press Enter to go down one row. Press Shift Equal (again, two keys to the right of zero on the number row) to make the plus sign. Up arrow once and you will hear “1250 has formula A3.” Your screen reader first says the result, then indicates this is a formula so you know it is not just a typed-in number. Then you hear the cell coordinate.
2. Subtraction: In cell A4, type in “=A1-A2,” minus the quotes, and press Enter. The dash is one key to the right of zero on the number row. Up arrow once and you will hear “750 has formula A4.” 
3. Multiplication: In cell A5, type in “=A1*A2,” minus the quotes, and press Enter. Press Shift 8 on the number row to make the asterisk sign. Up arrow once and you will hear “250000 has formula A5.”
4. Division: In cell A6, type in “=A1/A2,” minus the quotes, and press Enter. The Slash key is just below the semicolon on the Home row. Up arrow once and you will hear “4 has formula A6.”
Now we will cover formulas using some of the most frequently-used functions, including those for calculating the sum and average of values in a column, and finding the minimum and maximum values in that column. These formulas have a three-component structure: the equal sign, short text indicating the function to be calculated, and the data range upon winch that function will be performed. Because we have data in all the cells from A1 through A6, we will use this data range. To make it easier to read the text, I will put the formula on its own line and then explain it on the next line.
In cell A7, type:
=sum(A1:A6)
This totals the values in the column from cell A1 through cell A6. The three components of the formula are: 
· The equal sign indicating that this is a formula.
· The text of the function “sum” indicating that this is the calculation to be executed.
· The data range, written beginning with a left parentheses, the first cell in the data range, a colon indicating “through,” the last cell in the data range, and a right parenthesis ending the designation of the data range.
In cell A8, type:
· =average(A1:A6)
This calculates the average value (also knows as the mean) of the data range from A1 through A6.
In cell A9, type:
· =min(A1:A6)
This identifies the minimum value in the data range from A1 through A6.
In cell A10, type:
=max(A1:A6)
This identifies the maximum value in the data range from A1 through A6.
Excel has a vast variety of available functions that can be used to make calculations. A good starting point for learning more about functions and formulas is:
Overview of formulas in Excel
Here you can find introductory information on formula basics, descriptions of the most commonly used functions, how to construct more complex or advanced formulas and functions, and additional reference materials and tutorials.
5.2 Constructing a Table
5.2.1 Building Blocks for a Basic Data Table
Let’s put together a table with monthly expenses for the Smith family. You usually start by putting in a name or title at the top left of the worksheet in cell A1. Then you put text down column A and across row 2. Then you enter data in the middle of the table. Let’s get started.
1. In cell A1, type “Monthly Expenses for the Smith Family for the Year,” minus the quotes. 
2. Type “Expense” in cell A2, minus the quotes.
3. In column A, from cells A3 to cell A10, list the following eight expense categories: Water, Electricity, Groceries, Cell phone, Cable, Rent, Transportation, and Entertainment. 
4. In cell A11, type “Monthly Total,” minus the quotes. We will eventually sum the monthly columns along row 11. 
5. In row 2, starting in cell B2, type in the months of the year across this row, with January in cell B2, February in cell C2, and so on until December in cell M2.
6. In cell N2, type “Annual Total,” minus the quotes. We will eventually sum the rows to calculate the annual amount for each type of bill 
Not counting the name of the table at the top, most basic data tables are composed of three parts:
· Row headers: Text going down the left column. In this case, the types of bills. “Electricity” is a row header because the data along that row relate to electricity bills. 
· Column headers: Text going across the top row of the table. In this case, each of the twelve months and the last column totaling the year. “January ” is a column header because all the cost data down the January column relate to bill costs for that month. 
· Table body: To the right of the first column and under the top row is where data appear. If data are numeric (simple numbers, dollars, percentages, etc.), they are referred to as “values.” In this table, each monthly bill expense will be entered. 
5.2.2 Define Names – A Feature That Makes Using Excel Much Easier
After you have typed in your row and column headers, it is time to introduce an Excel feature that greatly improves readability of tables for screen reader users on the PC. When I show this feature to a screen reader user who has been struggling with Excel for a long time, he or she usually has one of those head-slapping “I wish I had known about this years ago” moments. 
Sighted users can easily interpret Data in the body of a table. Let’s say the number 750 appears in cell E8 of this table. With a quick glance, a sighted user can determine that this number corresponds to the cost of rent for April. However, a screen reader user would need to Up arrow several times to the top of the column to find April, Down arrow back to 750, and then Left arrow back to column A to figure this out. This is time-consuming in even a small table like this one. It is much worse with larger tables. 
Using the Define Names feature largely eliminates this problem. As you move cell by cell along a row, you will hear the column header and content for each cell,. As you move cell by cell up or down a column, you will hear the row header and content for each cell. With the JAWS Eloquence voice, column and row headers are spoken in a lower pitch than the cell data. 
To activate this feature correctly, you must start with your focus in the cell that is the intersection of the row and column headers you want read as you move around in the body of the table. Most of the time, this will be the cell in the top left corner of your table. This does not mean the name or title you gave the table, located in the row above in cell A1. 
In this table, the types of expenses are listed down column A and the months of the year are listed along row 2. The top left cell of the table is cell A2, so this is where your cursor must be situated in order to begin the process of defining names. Steps are:
1. As explained above, navigate to the cell that is the intersection of the column and row headers you want read as you navigate inside the table. In this case, move to cell A2.
2. Press the Applications key, Up arrow twice to Define Name, and press Enter. 
3. Type in the word “title,” minus the quotes, and press Enter. 
4. To test it out, move around inside the table. As you move right and left, you should hear the column headers and cell content. As you move up and down, you should hear row headers and cell content. 
This is an Excel feature, so works equally well with any of the screen readers covered in this book. When you save the file, title reading will also be saved. 
While you can activate this feature at any time, I get it going as early as possible when constructing a table. It makes all subsequent actions (data entry, navigation, creating formulas, editing, etc.) much easier and less prone to error. 
For some tables, you may not want to hear both column and row headers as you navigate, but just one or the other. For example, think of a bus schedule where the stops are listed along row 2,and down column A are the times of the first bus in the morning. In this case, hearing the row headers (that is, the time of the first bus) and times in the middle of the table as you up and Down arrow, would only be confusing. In this case, you would only want column headers read to you as you move left and right along rows. To hear only column headers:
1. Navigate to the leftmost cell in the row where the column headers are located (usually the top row of the table, not counting the row with the table name).
2. Press the Applications key, Up arrow twice to Define Name, and press Enter. 
3. Type in the single word “columntitle,” minus the quotes and with no spaces between column and title, and press Enter. Note that this is not case-sensitive. If you like, you can instead write it as “ColumnTitle,” with the C and T capitalized so your screen reader says it normally. 
4. To test it out, move around inside the table. As you move right and left, you should hear the column headers and cell content. As you move up and down, you should only hear cell content, and no row headers. 
To only hear row headers:
1. Navigate to the cell just above the topmost row header you want read, usually near the top of column A. 
2. Press the Applications key, Up arrow twice to Define Name, and press Enter. 
3. Type in the single word “rowtitle,” minus the quotes and with no space between row and title, and press Enter. Here too, use upper case for R and T if you prefer it to read normally. 
4. To test it out, move around inside the table. As you move up and down, you should hear the row headers and cell content. As you move left and right, you should only hear cell content, and no column headers. 
You also need to know how to delete these for a couple of reasons. First, if you mistakenly start the above steps from the wrong cell, table reading may become incomprehensible. You must first delete any previous title reading designations before you can correct them. Second, sometimes in the course of editing spreadsheets, you may delete some rows or columns. This may cause title reading to no longer work. Here too, you will need to delete whatever you first put in before you can redo them. You can start this process from anywhere in the spreadsheet. Steps are:
1. Press Alt to open the Upper ribbon, and Right arrow to the Formulas tab.
2. Tab into the Lower ribbon about ten times to the Name manager button and press Enter. The shortcut key is Control F3.
3. You land in a combo box where any Define name settings you have created for that file are listed. Assuming you only have one, your cursor focus lands on it. 
4. Press the Delete key. You are asked for a deletion confirmation.
5. Press the Spacebar to confirm, and Escape to return to your spreadsheet. 
It is also possible to define column and row headers for several tables on the same sheet. You will need to do this to avoid confusion. If, for example you have defined names for a table beginning near the top left of the sheet, and you then add more tables below or to the right of this first table, the column and row headers of the first table will be read as you navigate within these other tables. You will then hear the wrong column and row headers read. 
To define names for the first table on a worksheet with two tables, you need to specify the data range of that table. The column and row headers specified will only be operative within this data range, and will not interfere with reading column and row headers for any tables outside this data range. 
Using our current table as an example, the top left corner of the data range is cell A2. Because the furthest right column is column N, and the bottom row is row 11, cell N11 is the bottom right cell of the data range. Steps for defining names for this data range are:
1. Navigate to cell A2, the top left cell of the data range. 
2. Press the Applications key, Up arrow twice to Define Name, and press Enter. 
3. Type in “title..N11” here. After the word title, you type in two periods and then the bottom right cell coordinate of the data range. Now press Enter. 
4. To test it out, move around inside the A2-N11 data range where you will hear column and row headers. Now move the cursor outside this data range (to the right of column M or below row 11), you will no longer hear these column and row headers spoken.
Let’s now say there is a second table on this worksheet whose top left corner is in cell A15 and bottom right corner is in cell G23. To use the Define name feature to read this table’s column and row headers, repeat the above steps, substituting A15 as the start point in step 1, and cell G23 as the bottom left cell coordinate in step 3.
Finally, the same name cannot be repeated in a single file. If you are working with multiple sheets, you cannot use the word “title” on more than one of these sheets. If you attempt to do this, you will hear the following error message: “This name already exists. Names should be unique.” To get around this, instead type in “title1, title2, etc.” without the quotes or any spaces. 
In conclusion, the Define names feature is a great tool for making Excel sheets more readable. Use it whenever you create tables yourself, as well as when you receive a file from somebody else. The only piece of bad news is that they don’t always work for files you get from sighted people. This is because sighted folks sometimes insert lots of blank columns and rows to visually separate data categories. This makes it hard or impossible to find a cell at the top left corner that forms the intersection of the column and row headers you want to designate as titles. QuickBooks, a popular financial management application, generates balance sheets, profit and loss statements, and other standard accounting reports in Excel format that have this problem. 
5.2.3 Data Entry and Copying Formulas
Now it’s time to add some values in the body of the table. Beginning in cell B3, and going down to cell B10, type in numbers for each of the January expense types. Just type in numbers. Don’t worry about expressing them in dollars. That will come later. 
Remember that after typing in a number, you can either press Enter or the Down arrow key to go to the cell below. 
When finished, make sure your cursor focus is on cell B11, just one cell to the right of where you typed the word “Total.” 
In cell B11, we will sum the January column. When you are new to Excel, it can be a bit challenging to enter formulas. You should type slowly because you may not be accustomed to using several keys (left and right parentheses, the equal sign, and a few others). Excel is extremely unforgiving about any typing errors. Also note that there are never any spaces in formulas. Even if you are a proficient typist, entering formulas can be a painstaking process. However, the good news is that you won’t have to type too many of them. As we will see below, for the current table, you will only need to type in two of them. All the remaining formulas will be copied and pasted.
First, be sure you know the addresses of the first and last cells of the data range you want to sum. Here the first cell is B3 and the last one is B10. In cell B11, type:
=sum(B3:B10)
And press Enter. 
You can now copy the formula and paste it across row 11 to sum the columns for the other months, and the final total column. When copying and pasting files, folders or text, the order of operations is select, copy and paste. When copying formulas in Excel, the order is slightly different. First, you copy the formula. Second, you select a range of cells. And third, you paste the formula to those cells. Therefore, do the following.
1. In cell B11, press Control C to copy the formula. 
2. Right arrow to C11.
3. Press and hold down the Shift key and Right arrow to N11, the bottom cell of the last column in the table.
4. Press Control V to paste the formula. 
This works because Excel automatically adjusts the formula’s cell coordinates correctly as you paste across the row. For example, Right arrow a couple of times to cell D11 which is the formula for summing the March column. Press F2, the keystroke for editing individual cells, and press the Up or Down arrow key to read the formula. It should say:
=sum(D3:D10)
After pressing F2, you can also use the Left and Right arrows to read individual characters within the cell. When finished, press Escape to exit the cell edit mode. More on F2 later in this chapter. 
You can follow a similar process to sum a row and then copy and paste formulas down the relevant column. Once again, be sure you know the addresses of the first and last cells of the data range you want to sum. This time, we will start by summing the first bill category row (water), inputting the formula in cell N3. The first cell is B3 and the last one is M3. In cell N3, type:
=sum(B3:M3)
And press Enter.
Now do the following to copy the formula in cell N3 and paste it down column N to sum each bill category row for the year:
1. In cell N3, press Control C to copy the formula. 
2. Down arrow to cell N4.
3. Press and hold down the Shift key and Down arrow to N11, on the last row of the table.
4. Press Control V to paste the formula. 
When you are constructing a simple rectangular table like this one, and want to total all the rows and columns, it is this quick and easy. And you can do this early or later in the process of putting the table together. As data is inputted in the body of the table for each bill, the totals in the bottom row and furthest right column will automatically be recalculated. 
5.2.4 Number Formatting In Cells 
There are various ways that simple number formatting can be converted to other formats such as currency, percentages dates and time. We will use the Smith budget table as an example and format its numbers as dollars with two decimals. Initially, we will only do this for cell B3 – the top left cell of the data range containing numbers. Steps are:
1. With cursor focus on cell B3, press the Applications key, Up arrow to Format cells, and press Enter.
2. This opens a multi-page dialog box where you land on the Numbers tab.
3. Tab once to the Categories combo box, and Down arrow to Currency.
4. Tab once to the Decimal place Edit spin box whose default setting is two decimals. If you wanted to change this to zero, you would type this in. While in theory, you can arrow to zero, I have found that this works poorly, so it is better to type it in if you wished to change the number of decimals. 
5. Tab once to the Symbol combo box to select the type of currency. While there are more than 500 symbols to choose from, you land on dollars most of the time. If you land elsewhere in this combo box, press the Home key to get to the top of the list and Down arrow to Dollars which is second in the list. 
6. Tab to the Negative numbers list box which has four options: preceded by a minus sign; displayed as red; surrounded by parentheses; or both displayed as red and surrounded by parentheses. Sticking with the default (preceded by a minus sign) is best for accessibility. 
7. Tab to the OK button and press Enter to make changes.
Obviously, you would not want to make this change one cell at a time, but for multiple cells. Here are two alternatives. One way is to select the data range of cells for which you want to change the number formatting. For this spreadsheet, the top left cell of the data range with numbers is cell B3, and the bottom right one is cell N3. Here’s a super quick way to change the number formatting of this data range to dollars with two decimals:
1. With your cursor in cell B3, press Shift Control and End together. This will select all cells from B3 to N11, as well as all cells within this rectangular block.
2. Press Control Shift 4 on the number row to change the cell format to dollars with two decimals. This is a convenient shortcut key that I use all the time. 
Even faster, if all the cells with number values in the sheet are to be converted to dollars with two decimals, and are all contained in a single data region starting in cell A1, you can simply press Control A to select all cells from A1 to the bottom right cell in that data region. Then press Control Shift 4 to convert to dollars with two decimals. This will not affect the formatting of cells in this data range which currently contain words rather than numbers. If you later insert numbers in currently empty cells in this data range, they will appear as dollars with two decimals. 
There are twelve number format categories listed in the Category combo box of this dialog. Other than Currency which I already covered, the most commonly used ones and options for changing their formatting are:
· Numbers: decimal places, adding comma separators between thousands, and negative number formatting.
· Date: numerous options for displaying month, day, and year.
· Time: numerous options for displaying hour, minute, second, and A.M. or P.M.
· Percentage: number of decimal places.
· Special: Use this for columns containing ZIP codes to make them read properly. If you do not, the ZIP code will read like any other five-digit number (for example, “forty-four thousand three-hundred and thirty two”) rather than as individual numbers. Also,  for any ZIP code beginning with zero, the zero will disappear from the cell. For example, my ZIP code is 02072. Without this special formatting, only 2072 would appear in the cell, even though I typed a zero at the beginning. 
Below is a summary of shortcut keys that can help you out:
· Control 1: Open Cell format dialog. 
· Control Shift 4: Format as dollars with two decimals.
· Control Shift 5: Format as percentages with no decimals.
· Control semi-colon: Format cells with todays date in MM/DD/YYYY format. 
5.2.5 Merging and Centering Cells
We now come to what I consider to be the last step in creating a simple data table in Excel. Centering the name of the table just above its top row is something you may wish to do if you are planning to share the file with sighted users. This involves merging cells, that is, converting two or more cells into a single one. To merge and center the name of this table, do the following:
Go to cell A1 where the name of the table (“Monthly Expenses for the Smith Family for the Year,”) appears. 
1. Hold down the Shift key and Right arrow to cell N1, the rightmost column of this table. 
2. Press Alt H M to open the Merge submenu. You land on the Merge and center button. Press Enter on this.
Your screen reader will now say “merged cells A1 through N1.” If you press Insert F to hear about cell formatting, among other things, you will hear that its contents are horizontally centered. And if you Right arrow once, your cursor will land on cell O1 because cell A1 now extends to column N. 
The three other options in the Merge submenu are:
· Merge across: Merge cells horizontally with left-aligned content.
· Merge: Merge cells vertically. Cell content will be vertically aligned along the bottom of the cell. 
· Unmerge: Undo merging of previously merged cells. 
5.3 Editing Basics
Basic editing actions include selecting cells, data ranges, entire rows, columns, and sheets, as well as deleting, copying, moving and pasting them. Selecting, copying and pasting formulas were covered above in Chapter 5.2.3 and will not be repeated here. 
5.3.1 Editing Individual Cells 
To edit data within individual cells, press F2. When you press the Up or Down arrow key, your screen reader will say the entire cell contents. This is especially useful for reading formulas. After pressing F2, you can also use the Left and Right arrows to read individual characters within the cell, as well as use standard text editing keystrokes to delete or insert characters. Note that when you press F2, focus is placed on the right side of the cell. If you wish to keep changes after editing the cell content, press Enter. If you don’t want to keep changes, or you just want to get out of the cell, press the Escape key.
Often the quickest way to change cell content is to simply type over existing content and then press Enter, Tab, or arrow away from it. It is not necessary to select cell content before replacing it. 
5.3.2 Selecting and Editing Data Ranges
Similar to selecting text in other applications, like Word, several selection keystrokes involve combining the Shift key with navigation keystrokes. Below are a number of them. 
· To select a single cell, simply place your cursor focus on it.
· To select an entire row, press Shift Spacebar.
· To select an entire column, press Control Spacebar.
· To select multiple contiguous cells across a row one by one from left to right, hold down the Shift key and press the Right arrow repeatedly until you get to the end of the selection. Note that the Shift key must be held down from start to finish.
· To select multiple contiguous cells down a column one by one, hold down the Shift key and press the Down arrow repeatedly until you get to the end of the selection. 
· To select a rectangular block of cells. Starting with focus on the top left cell of the rectangular data range, press Shift Right arrow to select across a row, and Shift Down arrow down the right-most column to the cell at the bottom right of the data range. As you arrow along, your screen reader will read the content and address of the first and last cell in the data range you are selecting. 
· To execute zthe above three operations with fewer keystrokes: hold down the Shift Control and Right arrow keys to select across a row from the leftmost cell to the rightmost cell; hold down the Shift Control and Down arrow keys to select down a column from the top-most cell to the bottom-most cell; and use these two keystrokes to select from the top left corner cell to the bottom right cell in a rectangular data range. 
· Control A selects an entire data region, that is, a block of contiguous cells containing data.
Note that, in making any of the above data range selections involving the Shift key, you must hold down the Shift key throughout the process. If you lift it in mid-process and continue arrowing, the previously-selected cells will become unselected and you will need to start over.
After making any of the selections above, you can:
· Copy the cells to the Clipboard with Control C.
· Cut the cells to the Clipboard with Control X.
· Paste the cells from the Clipboard with Control V.
· Delete the cells with the Delete key. 
5.3.3 Inserting and Deleting Rows and Columns
You can insert and delete rows and columns via the Applications key. Here you can Down arrow to find the Insert and Delete commands. You can also use ribbon shortcut key combinations which are far more efficient. If you are going to work much with Excel, it is worth memorizing the shortcut keys. The ribbon shortcut key combinations all begin with Alt H because they are located in the Home tab of the ribbons. They are:
· Alt H I R: Insert row.
· Alt H I C: Insert column.
· Alt H D R: Delete row.
· Alt H D C: Delete column.
Remember that for ribbon keystroke combinations, press the keys one at a time. Do not try to hold them down together. 
Returning to the Smith Family Budget table, let’s say we want to insert a new row in the middle of the table. If your cursor is anywhere in row 5 and you press Alt H I R, row 5 will now become blank. That row’s previous content and everything below it will be moved down one row. If your cursor is anywhere in column B and you press Alt H I C, column B will now become blank. That column’s previous content and everything to its right will be moved one column to the right. Pressing Alt H D R will remove a row and move all rows below it up one row. Pressing Alt H D C will remove a column and move all columns to its right back one to the left.
To insert or delete multiple rows below where your cursor is currently positioned, press Shift Down arrow to select as many rows as you want, and then press Alt H I R or Alt H D R. If instead, you want to insert or delete rows above your current cursor position, you can press Shift Up arrow and then the same shortcut keys. 
To insert or delete multiple columns to the right of your cursor, first press Shift Right arrow to select them, and then press Alt H I C or Alt H D C. You can press Shift Left arrow if you want to select multiple columns to the left and then insert or delete them. 
If you have already put formulas for totaling rows or columns in your table, when you insert or delete rows and columns in the middle of your table, these formulas will automatically adjust correctly. For example, if I insert a new blank row 5, and the previous formula summing column B was:
=sum(B3:B10)
It will move down one row and become:
=sum(B3:B11)
But be careful. If you insert a new blank row just above the row with the sum formula, the formula will not automatically adjust. You will need to change it manually. This behavior is the same when you insert columns. 
If you have one or more formulas in existing rows and then you insert new rows, it is often a good idea to copy and paste one of the existing rows in to the new blank one. Then just change whatever you need to change in the new row while retaining the copied formulas. This is easy to do, saves time, and avoids mistakes. Steps are:
1. Press Alt H I R in a cell where you want to insert a new blank row.
2. Up or Down arrow to a cell in one of the other rows already containing data and formulas. Press Shift Spacebar to select the entire row.
3. Arrow back to the blank row and paste it with Control V.
4. Edit the new row data as needed without changing the copied formulas. 
5.4 Sorting Data
Sorting data is quick and easy in Excel. You can sort columns alphabetically, numerically and by date. I will start with sorting alphabetically.
If you are maintaining a list of contacts, you will often want to sort alphabetically by last name. Keep this in mind when first preparing your data table. Either input last names first, as in “Smith, John,” or create separate first and last name columns. If you input names in a single column and begin with first names, you will not be able to sort the data by last name. Assuming you have created a last name column, steps for sorting alphabetically are:
1. In the last name column, place your cursor on any of the cells containing a last name. Do not place it on the “last name” column header.
2. Press the Applications key, Down arrow to the Sort submenu, and press Enter. 
3. You first land on A to Z. Down arrow to see the two other choices, which are Z to A, and by color. Avoid sorting by color because it is generally inaccessible.
4. Press Enter on A to Z and the column and its associated row data will now be sorted alphabetically with last names beginning with A at the top of the column.
To speed up this process, you can first press the Applications key and then press the letter O to get right into the Sort submenu.
If there are any blank cells in this column, their associated row data will be moved to the bottom of the table. 
To sort numeric column data, steps are pretty much identical. The only difference is that when you open the Sort submenu, choices are Smallest to largest and Largest to smallest. If, for example, you had a column with rankings (1 as best and 50 as worst), it would make sense to sort smallest to largest. In the Smith family budget table, you might want to sort the Annual total column largest to smallest so that the highest cost items appeared at the top of the table.
If there are any blank cells or text data in this column, their associated row data will be moved to the bottom of the table. For example, if you inputted “not available” in several cells in this column, all associated row data would be moved to the bottom after sorting. 
To sort by date, here too, steps are identical, the only difference being that choices are oldest to newest and newest to oldest.
As above, for any blank cells or text data in this column, their associated row data will be moved to the bottom of the table. Because of the way dates are coded in Excel, sorting by date only works for data after the year 1900. 
When sorting column data, there are a couple of potential complications to guard against. When sorting alphabetically, it is possible that the row containing column headers could find its way into the middle of the table. For example, if row 2 contained column headers and you sorted by the Last name column, this row’s data could wind up in the middle of the table with the L in Last name causing it to move there. 
If the last row contains formulas for summing the columns and you then sort numerically, this last row will be moved to the top of the table, just below the row containing the column headers. This would happen with The Smith family budget table. 
Inserting a blank row between the column headers row and the first row with data will avoid the first problem. If the column headers are contained in row 2 and the actual data begins in row 3, with your focus somewhere on row 3, press Alt H I R, making row 3 blank and shifting all the data rows down one row. Sorting alphabetically will now work correctly. 
To correct the second problem, insert a blank row between the bottom row where any sum formulas are located, and the data row just above it. Sorting numerically will now work. 
5.5 Multiple Worksheets
So far, all our work has involved a single worksheet. However, you can have multiple worksheets in a single file. With large datasets and multiple tables, it quickly gets unwieldy to place them all on a single worksheet. Printing them in hard copy can also be a nightmare. If you have detailed company sales data for a year and want to present it on a monthly basis, it probably makes more sense to create twelve worksheets rather than put all twelve tables on a single worksheet. 
To navigate an Excel file with multiple worksheets, press Control Page down to go to the next worksheet and Control Page up to go to the previous worksheet. This is a Windows keystroke so works with all three screen readers. 
With JAWS, you can get a list of worksheets by pressing Control Shift S (think of S for “sheets”). You can then Down arrow or first-letter navigate to a worksheet, and press Enter to open it. This is very useful for efficiently navigating a file with many worksheets. It is also helpful to see the order in which the worksheets are presented in case you want to reorder them. 
To get a list of worksheets using NVDA, do the following:
1. Press Insert F7 to open the Elements list.
2. Shift Tab once and Down arrow to the Sheets radio button.
3. Tab once to the list of worksheets. 
4. As with JAWS, either Down arrow or first-letter to a worksheet and press Enter to open it. 
Getting a list of worksheets is not possible with Narrator. 
There are a number of actions you can perform with multiple worksheets, including inserting, deleting, renaming, and moving and copying them. JAWS has a context menu for managing worksheets where you can conveniently access all these commands. With NVDA and Narrator, you will need to find each of these commands in the ribbons. 
To open the Manage worksheets context menu, press Shift Insert S. I try to remember “SIS” - short for “sister.” In the order in which they appear as you Down arrow here, The most important commands are:
· Insert: When you press Enter, the first item is Worksheet. Press Enter again and a new worksheet will open with focus on cell A1. This worksheet appears one worksheet before the one where you started this operation.
· Delete: When you press Enter, you will be asked to confirm if you want to delete the current worksheet. Press the Spacebar on the Yes button if this is your intention.
· Rename: Generic worksheet names are Sheet 1, Sheet 2, etc. You should rename them if you plan on creating more than just a few worksheets. Otherwise, you will quickly lose track of which one is which. Press Enter here, type in a short name and press Enter again. If you then press Insert T, your screen reader will read the filename, followed by “Excel,” and the worksheet name at the end. 
· Move or copy: In this dialog, you first land on Move. After you have created a series of worksheets, use the Move command to reorder them. When you Down arrow to a worksheet in the list, pressing enter will insert the current worksheet just before it. The bottom item on the list is “Move to end.” Press Enter here if you want to place the current worksheet last. If instead you want to create a copy of the current worksheet, Tab once to the Copy checkbox and press the Spacebar. Then Tab one more time to the OK button and press the Spacebar. The copy will have the same name as the original worksheet, followed by the number two in parentheses.
· Select all sheets: Use this command if you want to copy multiple worksheets to a different file. This avoids having to copy them one at a time. 
Ribbon shortcut keys for the above commands that you can use with NVDA and Narrator are: 
· Shift F11: Insert new worksheet.
· Alt H O R: Rename worksheet.
· Alt H O M: Move or copy worksheet.
· Alt H D S: Delete worksheet.
The Paste link command allows you to copy and paste a formula from one worksheet to another. For example, let’s say you have monthly profit data on twelve separate worksheets. You can insert a summary worksheet with links to the total monthly profits formula in each of the monthly worksheets. If you make changes in any monthly worksheet that results in the total profit for that month changing, the change in the monthly total profit formula will be fed through to the summary worksheet. Continuing with this example, to paste a link from one worksheet to another, do the following:
1. Place your cursor on the cell in the monthly worksheet containing the total profits formula for that month, and press Control C to copy it. 
2. Navigate to the summary worksheet and place focus on the cell where you want to paste the formula. 
3. Press the Applications key and Down arrow to Paste options, but do not press Enter.
4. Instead, Left arrow once to the Paste link button and press Enter. 
The syntax of this formula contains: the equal sign, the worksheet name from which the formula is being copied surrounded by apostrophes, the exclamation sign, and the address of the cell being copied. For example, if the total profits formula was contained in cell E26 of the February worksheet, the Paste links formula in the summary worksheet would be:
=’February’!$E$26
Consider creating a summary worksheet for a file containing a large number of worksheets, and use the Paste links command to present data on this worksheet. It is a more convenient and effective way to communicate the most important data to colleagues, versus having these data scattered across a large number of worksheets. 
5.6 Filtering
Filtering allows you to temporarily hide some data in a dataset so you can zero in on those data that you want to examine more closely. This is especially useful for working with large datasets. Let’s say that you are the Eastern Massachusetts regional manager of a retail chain that operates throughout New England. The database you are working with contains 20,000 records with information on each store, employee, and transaction over the last year. If your goal is to focus on just the stores in the Boston area, filtering would allow you to temporarily narrow the visible data. Instead of having to wade through 20,000 records, most of which are not relevant, filtering would allow you to reduce the dataset to a more workable number of transactions. If you are only interested in analyzing data for the last three months, you could further narrow down the dataset using filtering. And if you want to focus on just a few products or employees, you could perform additional filtering. 
I will demonstrate using an example with far fewer entries. In this section and the next one on pivot tables, I will reference the file that accompanies this book entitled “Quarterly Sales By Employee.xlsx.” You may wish to open it to follow along and repeat the steps.
This worksheet contains quarterly sales data for employees in five electronics stores in the Boston area. Column headers in this workbook go across row 2 and include: 
· Store (column A): The five stores (Boston, Cambridge, Quincy, Watertown, and Newton).
· Employee (column B): The first names of three employees in each of the stores, for a total of 15 employees.
· Quarter (column C): Quarters one through four of a particular year.
· Product (column D): Three products sold in each of the stores, including iPhone SE, Samsung TV, and HP laptops.
· Quantity (column E): The number of each of these products sold by employee in a particular quarter.
· Price (column F): The unit price in dollars for each of the products.
· Sales (column G): The formula for price times quantity expressed in dollars.
As an example, we will filter to narrow focus to just the Cambridge and Newton stores for the first quarter, and iPhone SE sales. 
To turn on filtering, your cursor must be somewhere on the row containing the column headers (in this case, row 2). In addition, there can not be any blank rows between this row and the data rows. So, here goes:
1. With your cursor on the column headers row (in this example, row 2), press Control Shift L. If you now Left or Right arrow, JAWS and Narrator say “No filter applied auto filter drop-down.” NVDA does not say anything. 
2. Place your cursor on the cell containing the column header you first want to filter. We will start in cell A2 where the column header “Store” appears. 
3. Press Alt and Down arrow together. JAWS says “Type words to search for.” NVDA says “unknown.”
4. Shift tab three times until you hear “tree view. Select all checked.” Under this are listed all the items or values present in the column you are filtering by. In this case, these are the five stores identified above. 
5. Down arrow and press the Spacebar to uncheck all items that you want the filter to hide. We will uncheck Boston, Quincy, Watertown, while leaving Cambridge and Newton checked. 
6. When finished checking or unchecking items, Tab once to the OK button and press Enter. Be sure to Tab only once. You can easily Tab past it because you first hear “type words to search for” before hearing “OK button.”
7. Down arrow in this column. You will notice two things: only the rows with the stores you left checked will appear. The unchecked rows are hidden. In this case Rows A3 to A38 and A75 to A146 are skipped over as you Down arrow. Also, as you Down arrow, your screen reader will say “adjacent to hidden cells,” at the boundary between the hidden and unhidden rows. 
8. To further filter by quarter, go to cell C2 where the column header “Quarter” appears. 
9. Repeat steps three and four above. 
This time, press the Spacebar to uncheck the Select all checkbox. Down arrow to the first Quarter and check this checkbox. All other quarters you want hidden are already unchecked.
1. Tab once to the OK button and press Enter. 
2. For the final filter, go to cell D2 where the column header “Product” appears. 
3. Repeat steps three and four above. 
4. Again, press the Spacebar to uncheck the Select all checkbox. Down arrow to iPhone SE and check this checkbox. The other products are already unchecked.
5. Tab once to the OK button and press Enter. 
Once you have filtered to focus in on the data you want to analyze, you can select the entire worksheet by pressing Control A, and then copying and pasting the data into a new worksheet. Only the unhidden rows will be pasted into the new worksheet. Extracting the data this way from a larger dataset is preferable to attempting to continue working with it in the initial worksheet, especially if the dataset is large. 
In the above example, for some columns, I left the Select all checkbox checked and for others I unchecked it. If there are only a few items in the list, the decision to check or uncheck the Select all checkbox is fairly trivial. However, if the number of items listed is large. This is no longer a trivial decision. For example I once had a client who wanted to filter a column of vendors from whom his state agency had procured goods and services. There were over 700 vendors listed, and he was interested in displaying the data for just three vendors. It was important that he unchecked the Select all checkbox. After doing that, he was also able to first-letter navigate to quickly find the checkboxes for his three vendors. 
When you are finished filtering in the initial worksheet, from anywhere in that worksheet, you can press Control Shift L again, and all the hidden rows will reappear.
5.7 Pivot Tables
Pivot tables are useful for reorganizing relevant data fields into tables so you can zero in on the information you are interested in analyzing. They are called “pivot tables" because, from a visual perspective, dragging and dropping selected data columns from an initial data table “pivots” these into a new table.
I have used pivot tables for organizing conferences. I needed to track how many people had registered, how much they had paid, add up voluntary donations to the organization, their lunch choice, whether they preferred receiving the agenda electronically, in Braille, or large print, and several other things. I also used pivot tables to present results of a survey with ten or fifteen questions about the accessibility of voting machines. Without resorting to pivot tables, figuring out how to organize and report results would have been messier, much more time-consuming, and prone to computational error. An added bonus to using pivot tables is that, after initial construction, they are quick and easy to update as you add new data. In the conference example mentioned above, I was able to regularly update and report figures as new registration information came in prior to the conference. 
5.7.1 Creating Pivot Tables
A generic table consists of up to three parts. Using the simple example of the Monthly Expenses table from earlier in this chapter, and using pivot table nomenclature, these are:
· Row labels down the leftmost column where the different bill types are listed.
· Column labels along the top row of the table. In this case, the months of the year.
· Values, the actual data in the table, in this case, the dollar amounts of each bill. 
· These are the building blocks for constructing pivot tables. Pivot tables can have row labels and values, column labels and values, or both row and column labels and values. All must have values, and values must be numeric (quantities, dollars, percentages, etc.).
In this section, I will reference the quarterly sales by employee worksheet used in the previous section on filtering. I will construct several pivot tables from these data. The first one will be total sales by quarter for each of the stores. This will involve designating Store names as row labels, quarters as column labels, and sales amounts as values. Steps for creating this pivot table are:
1. Select the data range that includes the column header row and the data. In this workbook, the data range is A2 through G182. With your cursor focus on cell A2, a quick way to select this data range is to press Shift Control End. 
2. Press Alt to open the Upper ribbon, Right arrow once to the Insert tab, tab once into the Lower ribbon, and press Enter on the Pivot table button (the shortcut key is Alt N V).
3. You land in a dialog box where the selected data range is indicated. Assuming the data range is correct, press Enter here.
4. You now land on cell A3 in a new blank worksheet. Do not navigate away from this cell. Otherwise, the next step will not work. 
5. Press F6 a couple of times until you hear “pivot table fields, find words to search for.” 
6. Tab once where you will find all your column headers listed.
7. Down arrow to the first of these that you want to be part of your pivot table, either as a row label, column label, or value. In this case, you first land on “store,” which is the variable we want to use as a row label. 
8. Press the Applications key, Down arrow to Add to row labels, and press Enter. This returns you to the list of column headers. The checkbox for “store” is now checked. 
9. Down arrow to the next column header in the list that you want to be either a column label or value. In this case, it is “Quarter,” which will be the column label.
10. Press the Applications key, Down arrow to Add to column labels, and press Enter. Here again, you are returned to the list of column headers, and the checkbox for “Quantity” is now checked. 
11. Down arrow to the column header in the list that you want to be included for values. In this case, it is “Sales.” 
12. Press the Applications key, Down arrow to Add to values, and press Enter. You are returned to the list of column headers, and the checkbox for “Sales” is now checked. 
13. The pivot table is now ready to view. Press F6 four times until you have returned to the worksheet. You will know when you are there because you land in cell A3 every time. In this case, you hear “Sum of sales A3.”
Note that the order in which you add row labels, column labels and values does not matter. Simply add them in the order they appear as you Down arrow through the list. 
The table appears as follows:
· The five stores are listed down column A. 
· The four quarters are listed across row 4.
· The values appear in the body of the table. For example, the value of first quarter sales in the Boston store is contained in cell B5. 
· Grand totals by quarter appear across the bottom row of the table.
· Grand totals by store appear down the last column of the table.
· The grand total for all stores and all quarters appears in the bottom right cell. 
Note that the values only appear as simple numbers. Press Control A to select the entire table, and press Control Shift 4 to quickly change their format to dollars with two decimal places. Also note that you should rename the worksheet using the steps outlined in Chapter 5.5 so you don’t confuse it with other pivot tables you will be creating on other sheets. 
I frequently create pivot tables whose purpose is simply to count things. I mentioned above that I used pivot tables for planning a conference. I created pivot tables to count up the number of lunch choices, preferred agenda format (email Braille, large print), and a few more items. For these tables, I designated lunch choice and preferred agenda format as row labels. To add values, I inserted a column called “Quantity,” that I filled with the number 1 for all the entries. 
5.7.2 Filtering Pivot Table Data
You can filter pivot tables to narrow your focus. Using the table we have just constructed, let’s say we are only interested in sales of the Boston store in the first quarter. We can filter this table as follows:
1. Navigate to cell A4 which contains the text “row labels,” and press Alt Down arrow to open the Filter dialog. 
2. Shift Tab to the tree view where you land on the Select all checkbox which is checked. Press the Spacebar to uncheck it, thus unchecking all the store names underneath it in the list. 
3. Down arrow to the Boston checkbox and press the Spacebar to check it. If you wanted to include other stores, you would Down arrow to them and check them too. 
4. Tab once to the OK button and press Enter. The other store rows are now hidden. 
5. To filter the quarters, navigate to cell B3 which contains the text “Column labels,” and Down arrow to open the Filter dialog.
6. Shift Tab to the tree view where you land on the Select all checkbox which is checked. Press the Spacebar to uncheck it, thus unchecking all the quarters underneath it. 
7. Down arrow to the first quarter checkbox and press the Spacebar to check it. 
8. Tab once to the OK button and press Enter. The other quarter columns are now hidden and only the Boston first quarter sales values appear. 
A wide variety of pivot tables can be constructed with a dataset such as that contained in the original worksheet. These might include:
· Total sales by employee
· Total sales by product.
· Product sales by store. 
· Product sales by quarter.
These could be filtered to narrow in on subsets of products, employees, quarters, or stores. 
5.7.3 Refreshing Pivot Tables
Once you have created a set of pivot tables, it is quick and easy to update them as new data is inserted in the initial data table, and as long as you use the following trick. If you want to insert new rows, insert them somewhere in the middle of the table rather than under the bottom row. Similarly, insert new columns between existing columns, rather than after the last one. The data range captured for recalculating the pivot tables will automatically adjust. Once you have inserted the new data:
1. Navigate to any of the sheets containing a previously-created pivot table.
2. Place your cursor on any cell with data in it. 
3. Press the Applications key, Down arrow to Refresh, and press Enter.
All pivot tables are now updated with the new data incorporated in the calculations. 
By contrast, if you add new rows below or new columns to the right of the existing ones, refreshing is more time-consuming. If at all possible, avoid doing this because you will need to repeat the steps below for each pivot table that you want to refresh.
Let’s say I have added data for a sixth store. The previous data range was A2 through G182, and now has been extended to G219. Also let’s say the name of the sheet is “data.” Steps for refreshing an individual pivot table are:
1. Navigate to the sheet containing one of the pivot tables you wish to update and place your cursor somewhere in this table.
2. Press the Alt key to open the Upper ribbon, and Right arrow to the Pivot table analyze tab. Note that this tab only appears when your cursor is situated in a pivot table. 
3. Tab into the Lower ribbon to the Change data source split button and press Enter. 
4. You land in an edit field where you type in the sheet with the raw data and the data range. The syntax is: the name of the sheet followed by the exclamation mark and then the new data range. In this case, type “data!a2:g219”without the quotes. 
5. Tab to the OK button and press Enter. 
This pivot table is now refreshed with calculations incorporating the new data. Unfortunately, you will need to repeat these steps for all previously-created pivot tables that you wish to refresh. In light of this, it is preferable to insert the rows for the sixth store somewhere in the middle of the data table rather than below the bottom row. 
5.8 Visual Considerations and Printing Worksheets
5.8.1 Adjusting Column Width
You can manually adjust column width or automatically resize columns to fit the data. The automatic option is called “autofit.” If you are sharing spreadsheets with sighted people, it is important to know if your column widths are correct. Otherwise, they may be unable to see data in some of the cells. JAWS calls this issue “cell text visibility,” and I will use this term here. 
If a column is not wide enough to accommodate the content of a particular cell, and the cell to its right also contains content, what you hear using a screen reader program and what visual users see is different. And this also differs between cell content that is text or numbers. 
With respect to cell content that is text, screen reader programs will read all cell content, regardless of whether the column in which it is contained is wide enough, and even if there is content in the cell to its right. If there is content in the cell to the right, sighted users will only see the text that fits within the current column width. If a sighted user places focus on a particular cell, that cell’s full text becomes visible in the Formula bar, a long thin rectangle near the top of the screen and under the ribbons. The Formula bar extends to the right edge of the screen. 
If a cell text visibility problem exists, NVDA indicates this by default. The JAWS default is to not indicate it, but a setting can be changed for individual sheets. Narrator does not currently have a way to identify cell text visibility problems.
For JAWS, turning on the setting to detect cell text visibility problems is done in Quick Settings. See Chapter 8.1.4.1 on how to do this. Unfortunately, it can only be changed for one file at a time, and cannot be switched to become the default setting. In addition, I have found that JAWS does not reliably indicate when there is no longer a cell text visibility problem. In my opinion, this is one area where NVDA does a better job than JAWS. NVDA identifies this problem without having to change a setting, and is also more reliable in telling you when you have fixed it.
If a column is not wide enough for the text content in cell A7, and there is content in cell B7 to its right, JAWS and NVDA will identify this as a cropped cell. NVDA will say “cropped at A7.” If cell text visibility detection is turned on, JAWS will say “cropped right at B7.” If there is no content in cell B7, NVDA will say “overflows A7.” JAWS will say “overlaps near B7,” or whichever cell the text extends to on that row. 
With respect to numeric data with cell text visibility problems, what your screen reader says and what sighted users see may differ depending on software versions. With my current versions of JAWS, NVDA, and Excel, data are expressed using scientific notation. For example, the number five billion is expressed as “5E+09.” Sighted users may instead see the cell filled with the symbol for numbers. Narrator users hear the full number even though it is not visible.
Commands for changing column width are located in the Cells group of the Home tab but are hard to find. Instead use the shortcut keys, which are Alt H O W for adjusting manually and Alt H O I for autofit. While it is usually better to autofit rather than guess at a manual width, the manual command allows you to detect the current column width. However, its meaning is not immediately clear. Press Alt H O W, and you will hear something like 8.11. The default column width is specified as a number of characters. So this means that 8.11 characters in the current font can fit within the width of the column. Back in typewriter days, individual character size was fixed so that either 10 or 12 characters fit within one inch. Nowadays, fonts are proportional, meaning that letters like M take up more room than letters like I. Thus, expressing column width this way is of limited value. 
Changing workbook views allows column width to be expressed in inches. Steps for doing this for an individual file are:
1. Press Alt to open the Upper ribbon, and Right arrow to the View tab.
2. Tab into the Lower ribbon to the Workbook submenu and press Enter. You land on the Normal view which is checked by default.
3. Tab to the Page layout view and press Enter. 
4. Press Alt H O W, and column width should now be expressed in inches. 
This setting will be retained when you save the file. 
You can change the default view to the Page layout view as follows:
1. Press Alt F T to open Excel options, where you land on the General category.
2. Tab to the Default view for new sheets combo box, and Down arrow to Page layout. 
3. Tab to the OK button and press Enter. 
So finally, after all this, how do you go about changing column width? To change it manually, press Alt H O W, type in a new column width value, and press Enter. If you have changed to Page layout view, express the value in inches. It is not necessary to type the quotation mark for inches. 
To autofit a column:
1. Press Control Spacebar to select the column.
2. Press Alt H O I to autofit.
3. If you want to find out what the new column width is, press Alt H O W to see it, and then the Escape key when you are done. 
You could also select multiple columns by pressing Shift Right arrow several times across a row, then Control Spacebar to select the columns, and then you could either change column width manually or autofit them, as outlined above. However, with regard to autofitting this way, keep in mind that a table with lots of different column widths is unsightly. It is more appropriate to have a wider column where the row headers are located (Usually column A), and uniform widths for the remaining columns to the right.
5.8.2 Text Wrapping
You can wrap text so that it appears on multiple lines in a cell. You can format the cell so the text wraps automatically, or you can insert a manual line break. To wrap text automatically, select the cell or cells that you want to wrap, and press Alt H W. 
Data in the cell wraps to fit the column width, so if you change the column width, data wrapping adjusts automatically to shift text between lines.
You can manually insert a line break within an individual cell. To do this, navigate to the position in the cell where you want to add the line break, and press Alt Enter. 
In cells with wrapped text, JAWS indicates this by saying “multiline cell.” Neither NVDA nor Narrator say anything to indicate the presence of text wrapping.
If text wraps to add new lines to an individual cell, the height of the entire row adjusts to accommodate this change. Content in other cells on this row are vertically aligned to the bottom of the cell. 
To hear the height of the current row, press Alt H O H. To find out how many lines are in the current cell, press F2 and Down arrow to read line by line. 
5.8.3 Headers and Footers
Headers and footers can be added to appear at the top and bottom of printed pages, respectively. Information commonly inserted in headers and footers include file and worksheet names, date and time the file was last revised, and page numbers.
There are quite a few built-in options that can be inserted. To insert a header or footer:
1. In the Insert tab, press Control Right arrow to move to the Text group, and press Enter to open the Text submenu. Tab to the Header and footer button and press Enter. The shortcut key is Alt N H 1.
6. You first land in the Center section of a blank Header pane. Press Tab and Shift Tab to move between the left, center, and right sections of this pane. You can also press Page down and Page up to toggle between the header and Footer panes.
7. While in either the Header or Footer pane, press Alt to open the context-specific Header and footer tab. 
8. Tab into the Lower ribbon where you will find an array of built-in fields, including: page number, number of pages, current date, current time, file path, file name, and sheet name. There are also a Header submenu and Footer submenu with additional built-in options you can select. 
9. Press the Escape key when finished adding your built-in choices. 
With JAWS, you can press Insert F1 for Screen-sensitive help to detect the presence of headers or footers. If, for example, there were a header containing the filename, JAWS would say “header:,” followed by the filename. With NVDA and Narrator, you will need to use the header or footer Edit command to see what appears in the Header or Footer panes. The shortcut keys to quickly get there are Alt N H E for the Header pane, and Alt N O E for the Footer pane. Once you are there, Tab to hear what appears in the left, center and right areas of the pane 
To remove a header or footer, the shortcut keys are Alt N H R and Alt N O R, respectively. I find that if I need to edit a header or footer, it is easier to remove the existing one and start over, rather than try to edit it. 
5.8.4 Formatting Tables
If you intend to share your worksheets with sighted people, you can make them more visually appealing by using table styles which adds a number of visual elements, including bolding column and row headers, and varying background shading of alternating columns or rows. You can also add borders around entire tables, selected rows, columns or cells to make them stand out. If you have never done this before, ask experienced sighted Excel users about appropriate table formatting choices. 
5.8.4.1 Table Styles
It is easy to select a table style, but understanding the pattern of the table styles is not readily apparent without a few workarounds. 
To illustrate, I will use the example of a quarterly sales table of a retail store, where the name of the table “Quarterly Sales of the Acme Company ” appears in cell A1, its various products are arrayed down column A, beginning in cell A2 where the column header “Product” is written, and the various products appear from cells A3 through A9, and the four quarters are enumerated in cells B2 through B5. The word “Total” appears in cell A10 and cell F2. Column and row totals will be summed in rows 10 and column F, respectively. Therefore, the table’s data range begins in A2 at the top left corner and F10 at the bottom right corner. The table name in cell A1 is not part of the table. 
Steps for selecting a style for this table and then adapting it to your wishes are:
1. [bookmark: _Hlk69719688]Select the table’s data range, which in this case is A2 through F10. To do this quickly, with your cursor in cell A2, press Shift Control Right arrow to select across to cell F2, and while continuing to hold down the Control and Shift keys together, Down arrow once to cell F10. Your screen reader will say the content and coordinate of the top left cell and then the content and coordinate of the bottom right cell.
2. Press Alt H T, which is the ribbon shortcut key to get into the Format as table submenu. 
3. This opens a table styles gallery. Right arrowing here presents a series of colors, including white and black/grey, white and blue, white and orange, white and grey, white and yellow, white and blue (lighter shades than the first set of blue and white options), and white and green. Down arrowing presents various shade levels of those colors (light, medium and dark). Arrow to a color and shade that appeals to you and press Enter to choose it. 
4. You land in a dialog box where the cell range chosen is repeated. Tab once to the My table has headers checkbox and press the Spacebar if you want the top row to serve as the column header row. This will bold the column headers.
5. Tab to the OK button and press Enter.
This data range is now a formatted table. To get a sense of the characteristics of the table style you have chosen, beyond just its color and shading, and with your cursor placed somewhere in this data range:
1. Press Alt to open the Upper ribbon, and Right arrow to the Table tools table Design tab. This is a context-specific tab. It will only appear if your cursor is situated in the table’s data range. The shortcut key to get to it is Alt J T.
2. Press Control Right arrow to navigate to the Table styles options group in the Lower ribbon.
3. In this group, Tab through the various options to see which of the following checkboxes are checked or unchecked: header row, totals row, banded rows, first column, last column, and banded columns. If banded rows or columns are checked, this indicates that alternating rows or columns are shaded with the color selection you made. Check first column if you want to bold it. If header is checked, that row will be bolded. If totals are checked, a totals row will be added. 
4. Press the Spacebar on any of these if you wish to check or uncheck them. Unfortunately, modifying a single one throws you back into the table. You have to repeat the above steps to get back here and continue modifying them one by one. 
5. Repeat these steps until you have the desired formatting.
Note that checking the Header row and First column checkboxes will bold their cell content. In JAWS, they will also be read similarly to when the Define names command is used to speak column and row headers as you navigate within the table. However, headers are not consistently read with NVDA and Narrator. Therefore, to be sure they read properly, you should still use Excel’s Define name command for reading column and row headers (see Chapter 5.2.2 above).
To turn off table formatting so that the data range reverts to its original formatting, do the following:
1. Select the data range of the table. 
2. Press Alt H E F to clear formatting. 
3. Press the Applications key, Up arrow to the Table submenu, Down arrow to Convert to range, and press Enter. 
4. You are asked whether you want to convert the table to a normal range. Press the Spacebar on the Yes button to confirm.
If you add banded rows or columns, you wan to be sure they have sufficient color contrast with the cell content. The Excel Accessibility Checker is a useful tool for doing this. Access it as follows:
1. Press Alt, Right arrow to the Review tab, Tab to the Check accessibility split button, and Press Enter.
2. Tab to Inspection results. If you hear “no accessibility issues found,” then your table style choice is OK. However, if you hear “warnings,” then Down arrow through the results, presented in a tree view. This will reveal the problem, saying “hard to read text contrast,” and naming the sheet where the problematic table appears. 
3. If this happens, clear the table style, choose another one, and run the Accessibility Checker again.
Here are a few hints and caveats about the process of adding table styles:
· When you open the file, if you hear that it is in compatibility mode, this means that the file was originally saved in the older 1997/2003 Excel file format rather than the newer one beginning with Excel 2007. Turn this off for more dependable outcomes. Also note that the Accessibility Checker will not work in compatibility mode. Press Alt F I to get to the Info tab, Tab to the Compatibility mode convert button and press Enter. You will be asked to save it, which you should do. 
· Navigating to the table Design tab on the Upper ribbon requires pressing the Right arrow quite a few times. If you are going to navigate there several times to modify format options, use the shortcut key which is Alt J T. Then press Control Right arrow to more quickly navigate back to the Table styles options group in the Lower ribbon.
· Don’t check the Total row checkbox. It gives unreliable results. 
· If you are going to add shading, select either banded columns or banded rows for easier readability for sighted readers.
· As of the writing of this book pressing Insert F gives more dependable information about font color with NVDA and Narrator than with JAWS. However, none of the screen readers are very dependable for identifying format information. 
5.8.4.2 Adding Borders
You can also format tables by surrounding the entire table, as well as cells within it, with borders of varying thickness. I should first clarify the difference between borders and gridlines. Borders of varying thickness may be added to make tables and/or parts of those tables stand out on the computer screen and on printed pages. Gridlines are thin horizontal and vertical gray lines that visually differentiate boundaries between cells on your computer screen. If you add borders, they will appear on both your computer screen and printed pages. Gridlines appear on your computer screen but not on printed pages, unless you change a setting to make them appear when printed.
As an example, lets format the table discussed above by adding thick borders on the top, bottom, left, and right edges of the entire table, another thick border below the column header row to set it apart from the other rows, and thin gridlines around the remaining cell edges in the table. Steps are:
1. To add thick borders around the entire table, select the table’s data range: A2 through F10. 
2. Press the Applications key, Up arrow to Format cells, and press Enter. This opens a multi-page dialog box. Press Control Tab until you get to the Borders page. 
3. Tab once to a series of radio buttons for adjusting border line thickness. Down arrow to the Thick radio button. 
4. Tab to the Outline button and press the Spacebar. Now Tab through and you should hear that the top, bottom, left and right checkboxes are checked. Because you initiated this process by selecting the entire table, this choice will add thick borders around the entire table while leaving gridlines around all the interior cell edges.
5. Tab to the OK button and press Enter.
6. To now add a thick border to the bottom edges of the column header cells, select the cells in row 2 (cells A2 through F2). 
7. To get to the Borders dialog more quickly, press the Applications key, and then F. Your focus should immediately land on the Borders page of the Format cells multi-page dialog box. 
8. Tab once. Your focus should still be on the Thick radio button. 
9. Tab to the Outline button and press the Spacebar. As you continue tabbing, you should again hear that the top, bottom, left, and right checkboxes are checked. The edges around the entire row will be thick, while the interior vertical edges will remain as gridlines.
10. Tab to the OK button and press Enter.
11. To also print the gridlines of the remaining cell edges, press the Alt key, Right arrow to the Page Layout tab, press Control Right arrow until you get to the Sheets group. You first land on the View gridlines checkbox. Tab one more time to the Print gridlines checkbox and press the Spacebar to check it. When I tabbed to this command on my computer, my screen reader only said “print.” But when I tabbed past it, and Shift tabbed back to it, it said “gridlines print.”
To remove borders:
1. Select the desired data range.
2. Press the Applications key, and then F. Your focus should immediately land on the Borders page of the Format cells multi-page dialog box if you were there previously. If you land elsewhere, press Control Tab until you get there.
3.  Tab to the None button, and press the Spacebar to check it.
4. Tab to the OK button and press Enter.
Adding borders correctly may require a fair amount of trial and error. JAWS has an extremely useful keystroke for revealing the border pattern of individual cells. After making border changes, spot-check them by navigating to a few cells and pressing Alt Shift B to check their border formats. For example, after I made the changes above, when I pressed this keystroke with my cursor in cell A2, JAWS said “Black thin gridline right edge, thick black continuous left, bottom and top edge borders of active cell.” Spot-checking a few other cells in the table confirmed that I had formatted borders as intended. However, when I tried to mix things up a bit by adding borders of varying thickness, results were unreliable. Therefore, I would recommend that if you try to add borders, don’t attempt anything too elaborate. If using JAWS, continuously check your work with the Alt Shift B keystroke. Unfortunately, I am unaware of any reliable way to check border formatting with NVDA or Narrator.
Finally, you may wish to bold the cell content of selected rows or columns, such as column and row headers, or total rows or columns. This is easy. Simply select the data range, and then press Control B to bold it. 
A final observation: formatting Excel tables is finicky and temperamental. Screen reader feedback may be less than reliable. Consequently, the only way to be absolutely sure that you have formatted your table as intended is to have a sighted person look it over.
5.8.5 Printing
You can print individual worksheets, all worksheets for a multi-sheet file, or a selected data range or print area in a worksheet. To print a data range in a worksheet rather than the entire worksheet, first select the block of cells using the keystrokes discussed in Chapter 5.3.2 above. Steps for printing are:
1. Press Control P to open the Print dialog.
2. Press Tab to the Print what combo box, and Down arrow through the choices, which are: active sheets, entire workbook, and selection. Press Enter on your choice. 
3. If you are ready to print, press Tab to the Print button and press Enter. Otherwise, press the Escape key. 
If your data selection is too large to fit on a single page, you need to consider how it will be arranged on multiple pages. Elements to consider include page size, font size, margin dimensions, and column and row height. Here are the Excel default settings, and I will use them in this section:
· Page size of 8.5 inches wide by 11 inches high in portrait mode. 
· Calibri font with 11 point size.
· Top and bottom margins of 0.7 inches, and left and right margins of 0.75 inches.
· Column width of 0.7 inches and row height of 0.2 inches.
· No headers or footers, presence of which can effect the number of rows that fit on a page.
Based on this configuration, eight columns and 47 rows of data can fit on a single page on my computer. I am not prepared to say that this is universal, but it will work for illustrating what follows in this section. 
If a worksheet has more columns and/or rows of data than will fit on a single page using this configuration, you need to know a few techniques for printing. JAWS in particular, has some useful tools to aid in the printing process.
Let’s say we have a worksheet that has 15 columns (from column A to O) and 65 rows. All this data will not fit on a single page. With JAWS, pressing Control Shift B brings up the Cells and page breaks list. This identifies where horizontal and vertical page breaks occur. In this case JAWS identifies the horizontal page break at A48, meaning that row 48 will be the first row on the second page. Down arrow once and JAWS indicates a vertical page break at cell K1, meaning that column K will be the first column on the second page.
Pressing Insert F1 brings up JAWS Screen-Sensitive Help. Among other things, JAWS reads the following print-related information: 1 horizontal full page break, 1 vertical full page break, and 4 portrait pages can be printed from this worksheet.
The data ranges and default order of printing will be:
· A1 to J47 on page one.
· A48 to J 65 on page 2.
· K1 to O 47 on page 3.
· K48 to O 65 on page 4.
If you print a data range with horizontal page breaks, you will want to be sure that column headers appear on every page. Otherwise, readers will have difficulty interpreting data on page two and beyond. Likewise, If you print a data range with vertical page breaks, you will want row headers to appear on every page. And If you print a data range with both horizontal and vertical page breaks, both column and row headers should appear on each page. To do this:
1. Press the Alt key to open the Upper ribbon, and Right arrow to the Layout tab.
2. Tab into the Lower ribbon to the Print titles button and press Enter. The shortcut key is Alt P I. 
3. Tab to Rows to repeat at top. If your print selection will have one or more horizontal page breaks, type here the row number or numbers of your column headers. If column headers are in row 2, type in here “2,” minus the quotes. If column headers are in two rows, say two and three, type “2:3” here, minus the quotes. The colon indicates rows two through three. 
4. Tab to Columns to repeat at left. If your print selection has one or more vertical page breaks, type here the column letter or letters of your row headers. This is nearly always just Column A, so type “A” here, minus the quotes.
5. Tab to the Grid lines checkbox, and press the Spacebar to check this if you want narrow grid lines to appear between cells. This is one way to make table reading clearer for sighted viewers.
6. Tab to the Down then over radio button. This indicates the order of how data ranges will be printed. Leaving it this way results in the print order indicated above. Down arrow once to the Over then down radio button if you wish to change the page printing order.
7. Tab to the OK button and press Enter.
If possible, try to avoid data spilling onto lots of printed pages. An excessive number of vertical and horizontal page breaks can make it hard to understand the information if it is carved up into lots of slices. You should also avoid printing pages with just one or two columns or rows. If you find yourself in such a situation, there are a few things you can do. First, if the page is not wide enough to accommodate all your columns, switch from the default portrait mode to landscape mode by pressing Alt P O, Down arrowing to the Landscape button, and pressing Enter. Two or three more columns will now fit on a page, but with about twelve fewer rows. 
Second, you can adjust margin dimensions to make them narrower, thus allowing more columns to fit on a page. To do this, press Alt P M, Tab to the Narrow margins button and press Enter. This changes the left and right margins from the 0.7 inch default to 0.25 inches, thus adding a bit less than one inch for fitting columns. This may not sound like much, but sometimes every little bit counts. 
Third, you can use the Scale to fit feature in the Print dialog. Steps are:
1. Press Control P to open the Print dialog.
2. Tab to the Scale to fit combo box and Down arrow through the choices, which are: no scaling, fit sheet to one page, fit all columns on one page, fit all rows on one page, and custom scaling options where you can designate a percentage for decreasing the size of characters on the printed page. 
3. After making your choice, Tab once to get out of the combo box and lock in your choice. There is no OK button here. 
4. If you are ready to send your work to the printer, Tab to the Print button and press Enter. 
Scaling to fit does not change the point size in your electronic file, but it does change the point size of the text sent to the printer. You can calculate the point size of what is printed by pressing Alt P X. This indicates the percent of scaling. The default is 100 percent for no scaling. If you have introduced scaling, it might now say 75 percent. If the default font size is 11 point, 75 percent of this equals an 8.25 point size. You then need to judge if this is large enough to be easily visible to sighted readers. If you opt for custom scaling, with the 11 point default, you probably shouldn’t go much below 70 percent. The best strategy is to ask sighted people who will be using the print out if they are able to read it.
5.9 Additional Tools and Features
Excel has many more tools and features. Some of the most useful ones are described in this section. Two features unique to JAWS – monitor cells and chart reading – are also described. 
5.9.1 Hiding and Unhiding Columns and Rows
In large sheets, using this feature aids efficient navigation by temporarily hiding columns or rows so you can quickly skip over them to get to columns or rows that interest you. Let’s say it’s now December and you want to input data for that month’s bills. You would like to temporarily hide all the columns from January through November. If you do this, only three columns will remain visible: column A with the bill names, the December column, and the Annual Total column. 
Steps for hiding the February through October columns (columns B through L) are:
1. With your cursor anywhere in Column B, hold down the Shift key and Right arrow to select across to column L.
2. Press Control Spacebar to select these columns.
3. Press the Applications key, Up arrow twice to Hide, and press Enter.
In column A, you will now hear “adjacent to hidden cells.” Right arrow once and you will be in column M, again hearing “adjacent to hidden cells.” This indicates that columns B through L are hidden. 
When you are ready to unhide columns B through L, do the following:
1. With your cursor on Column A (the column just to the left of the hidden columns), hold down the Shift key and Right arrow once to column M (the column just to the right of the hidden columns).
2. Press Control Spacebar to select these two columns.
3. Press the Applications key, Up arrow once to Unhide, and press Enter.
You can follow a similar process to hide and unhide rows. Remember that selecting multiple rows involves holding down the Shift key, Down arrowing, and then pressing Shift Spacebar to select them. After selecting rows, steps for hiding and unhiding them via the Applications key are the same as for columns.
5.9.2 Comments
Similar to Word, you can easily add comments to Excel workbooks while reviewing work with collaborators. You might also insert comments to explain how a formula was calculated or identify data sources. Comments are cell-specific, so start with your cursor focus on the relevant cell. Now press Shift F2, type in your text, and press Enter. Alternatively, you can press the Applications key, Up arrow several times to New comment, and add your comment from there. 
JAWS indicates that a cell has an associated comment by saying, “has comment, contains note.” NVDA says “has comment,” and Narrator says “contains note.” 
Excel 365 has added a feature for inserting notes. In theory, these are different from comments in some way. However, as of the writing of this book, I don’t think that any distinction is helpful, at least for screen reader users. Regardless of whether you insert a comment or a note, the screen readers say the same thing. 
While it is theoretically possible to reply to a comment, I was not able to figure out how to do this. I suggest sticking with comments for now. If you want people to reply to your comments, figure out a workaround of some sort, rather than attempting to reply to a comment within the comments feature framework. 
To delete a comment, place your cursor on the associated cell coordinate, Up arrow to Delete note and press Enter. Note that it might say “delete comment” in earlier versions of Excel. 
With JAWS you can press Control Shift Apostrophe to get a list of comments. You can then Down arrow through them to hear them, as well as press Enter on a comment to navigate to the associated cell. If your cursor focus is on a cell containing a comment, you can press Alt Shift apostrophe to hear it, as well as its author. 
At this time, neither NVDA nor Narrator have keystrokes for accessing a list of comments. While it is theoretically possible to get a list of comments in Excel itself, this does not give a list that is accessible.
5.9.3 Removing Unwanted Verbosity 
You may want to disable several Excel settings options that create confusing and distracting verbosity. Repeated prompts like “Quick analysis lens” or “Paste recovery options” can throw you off-track. When you type formulas beginning with a letter, you may hear things like “=A abs,” or “=B bottox,” which may confuse you. You can Eliminate this unwanted verbosity in the Excel Options dialog. Note that each of the category dialog boxes are extremely lengthy. Consequently, after making desired changes, it is much quicker to Shift Tab back to the OK button rather than Tab forward to it. Note also that the various settings are organized in groups, and as you tab through them, yu must listen to the name of the group before hearing the dialog element. If you tab through too quickly, you can easily skip over the one you are looking for. 
Steps for making three changes I would suggest are as follows:
1. Press Alt F t to open the Excel Options Categories dialog.
2. You first land on the General Category. Tab to the Show quick analysis options checkbox (located in the User interface options group of this category) and press the Spacebar to uncheck it. 
3. Shift Tab to the OK button and press Enter. 
4. Press Alt F t to reopen the Excel Options Categories dialog.
5. Down arrow or press F to navigate to the Formulas Category.
Tab to the Formula autocomplete checkbox (in the Working with formulas group of this category), and press the Spacebar to uncheck it.
6. Shift Tab to the OK button and press Enter. 
7. Press Alt F t to reopen the Excel Options Categories dialog.
8. Down arrow or press A to navigate to the Advanced Category.
Tab to the Show paste options button when content is pasted checkbox (in the Cut, copy and paste options group of this category),  and press the Spacebar to uncheck it.
9. Shift Tab to the OK button and press Enter. 
5.9.4 Monitor Cells With JAWS
To facilitate quick navigation to especially important areas of a large worksheet, you can designate up to ten monitor cells or data ranges. You can set these up with shortcut keys or via Quick Settings. To do this using shortcut keys, navigate to the cell you want to tag as a monitor cell. If it is a data range, set the data range first. Then press Insert Shift 1 to tag it as monitor cell one, Insert Shift 2 to designate it as monitor cell 2, and so on. If you designate cell A5 as the first monitor cell, JAWS will say “setting monitor cell 1 to A5.” You can easily reassign monitor cells. For example, if you place the cursor on cell A14 and press Insert Shift 1, JAWS will warn you that this monitor cell is already assigned and ask if you want to replace it. Pressing Enter will confirm the reassignment of this monitor cell number.
Once assigned, you can read monitor cells individually or in a list. Press Alt Shift 1 to read monitor cell one, Alt Shift 2 to read monitor cell 2, and so on. Note that this only reads the cell content. It does not navigate to that cell. 
To open a list of monitor cells, press Control Shift M. I especially like this feature because you can see all your monitor cell coordinates and content together. Also, if you Down arrow to one of them and press Enter, it will navigate to that monitor cell.
You can also assign monitor cells, reassign them, and remove assignments in Quick Settings (see Chapter 8.1.4.3).
5.9.5 Creating Charts and Reading Them with JAWS
Charts are visual presentations of data that are often more effective for communicating results than tabular presentations. They are easy to create. But you might assume that they are inaccessible to screen reader users. Fortunately, JAWS has a very nice chart reading feature to make them accessible. 
Among the most commonly used chart types are:
· Pie charts: Used to represent each data item as a percentage share of a total value. Each item is represented as a slice of a pie. 
· Column charts: Typically used to compare several items in a specific range of values, such as comparing sales volumes of several retail stores. The numerical values appear as vertical columns. 
· Bar charts: Used to display the same data as column charts, but as horizontal bars instead of vertical columns.
· Line charts: Often used to present trends over time. Monthly stock or commodity prices are examples. 
I will demonstrate by creating a pie chart showing the number and percentage shares of annual tourist visits to New England from four countries. If you are using JAWS and want to try it yourself, open the practice file entitled, “New England Tourist Visits.xlsx.”
The countries are listed in cells A2 through A5. The corresponding numbers of tourist visits are listed in cells B2 through B5. The Steps for creating the pie chart are:
1. Select the data range containing the data, in this case A2 through B5. 
2. Press the Alt key to open the Upper ribbon. If you first land on the Home tab, Right arrow once to the Insert tab.
3. The Charts group is fairly deep into the Lower ribbon, so press Control Right arrow several times until you land on the Charts group, the first item here being the Recommended charts button.
4. Tab several times to the Insert pie or donut chart submenu, and press Enter.
5. You first land on the 2D pie button. This is a two-dimensional pie chart. There are several other choices here that you can arrow through, including a 3D pie chart which adds shading to give it a three-dimensional effect. We will stick with the 2D pie chart, so press Enter on that.
6. The chart is now visible to the right of the data. 
At this point, depending on your version of JAWS, sometimes it immediately begins reading the entire chart content, other times it does not. In any event, press Escape now. 
To access the chart and have it read to you, press Control Shift O which brings up a list of objects. “Objects” include charts, pictures, and illustrations. After pressing Control Shift O, you will hear something like “Chart 1, chart title E2 M17,” where cell E2 is the top left cell and M17 is the bottom right cell of the range where the chart has been inserted in the worksheet. This is the default chart title. 
Press Enter on it to select it (note that you must press Enter, Spacebar will not work), and JAWS will now start reading the chart’s content to you. JAWS may read the chart continuously or just the first line. If it stops reading after the first line, you can Down arrow to read it one line at a time, or you can press Insert Down arrow to read it continuously. Here’s what you will hear for this chart: “Chart Title, Description: Pie. Displays the contribution of each value to a total., legend: Series1 has 4 slices, slice 1 CATEGORY=England, value=40000, contributes 27 percent, slice 2 CATEGORY=France, value=30000, contributes 20 percent, slice 3 CATEGORY=Italy, value=20000, contributes 13 percent, slice 4 CATEGORY=Canada, value=60000, contributes 40 percent, This sheet contains only the chart.”
You can move, copy or edit charts. Let’s say you would like to change the data range where it appears visually on your worksheet. Do the following:
1. Press Control Shift O to access the list of objects. 
2. If the pie chart is the only object in your worksheet, you land on it. If not, Down arrow to it, and press Enter to select it. 
3. Press Control X to cut it to the Clipboard. 
4. Navigate to the cell where you want its top left corner to appear and press Control V to paste it there. 
You could also copy the chart by pressing Control C instead of Control X and paste it in a Word document. 
Finally, you can add chart titles, X and Y axis titles, table legends, and data legends. To do this, first select the chart by pressing Control Shift O, and Enter to select it. You can then press Alt to open the Upper ribbon, and Right arrow to the Chart Layout tab of the ribbon. Here you can Tab into the Lower ribbon to Chart title, Axis titles, Legend, or Data Labels to add or change these.
5.10 Strategies for Deciphering “Difficult” Spreadsheets
Unfortunately, some spreadsheets you receive from sighted people will not be laid out in a tidy rectangular block and may be difficult to decipher. Among accountants, the convention is to add lots of empty cells between the data. Spreading things out like this visually separates categories and sub-categories. However, this makes it difficult for screen reader users to interpret data. In addition, choosing the best cell to initiate the Define names command can be challenging, and will probably yield less-than-perfect results. 
The practice file entitled “Temple Income and Expenses.xls” is an example of a “difficult” spreadsheet. I received a version of this spreadsheet from a student who serves on a budget committee at her temple. She was having trouble figuring it out.[footnoteRef:1] The first clue that something funny was going on was when I pressed Control Home. Rather than landing in cell A1, I landed in cell C3 instead. I correctly guessed that the spreadsheet author was using the Freeze panes command. This is the sighted equivalent of the Define names command. It is used to “freeze” column and/or row headers so they can be visible no matter where the cursor is located in a spreadsheet. This is useful for sighted users in large spreadsheets. For example, if the cursor is located in cell O187, without freezing the appropriate columns and rows, it will not be possible to interpret the data in that cell without doing a lot of time-consuming navigation. This is because the cursor is located too far down, as well as too far to the right, to see the associated column and row headers.  [1:  For demonstration purposes, I have modified the sheet by deleting several columns with a number of budget sub-categories. ] 

To verify whether Freeze panes is turned on, and to disable it if you want to do that, the Freeze panes submenu is located in the View tab of the ribbon. To disable it, press the shortcut Alt W F, and, assuming it is checked, press Enter to disable it. Whether you disable it or not, you will still be able to navigate in the range that is frozen by arrowing or Control arrowing. 
Pressing Control and the arrow keys is very useful in this spreadsheet because its author has left many empty cells for visual layout purposes. If you go to the top of column A of this spreadsheet, and press Control Down arrow once, you jump to cell A3, which contains the word “Income.” If you continue Control Down arrowing, you will jump to total income in cell A33, expenses in A35, total expenses in cell A130, and net income in cell A132. Obviously, just arrowing down would waste lots of time. 
Down arrowing through column B reveals actual budget line items. Corresponding dollar amounts for each month begin in column C. Column headers for the months February 2019 through February 2020 appear in cells C2through Q2. Amounts are totaled in column S. Each of the monthly columns are visually separated by empty columns. 
If we place the cursor in cell B2 and initiate the Define name command here, this will greatly aid data interpretation. Cell B2 is the intersection of column B which contains the line items, and row 2 contains the months. 
After getting a grasp on the logic of how the categories are organized in column A, and choosing the best cell to initiate the Define name command, it is now possible to understand the financial data in columns C through S. You will not be able to hear the categories (income, expenses, etc.) while navigating within the body of the table, because categories and individual line items are spread over two separate columns. However, you can now begin to understand what is going on. 
Depending on how much effort you want to invest in making this spreadsheet more efficient to navigate and easier to understand, several tools discussed earlier in this chapter can be quite helpful. They are recapped below.
· Navigating with Control and the four arrow keys: In a large spreadsheet with lots of empty cells, this is your “best friend” for quick navigation. These key combinations will leapfrog you over groups of empty cells, as well as over continuous ranges of cells filled with data. Control and Down arrow together is especially useful for moving down the first few columns of this spreadsheet because there are so many empty cells. Down arrowing cell by cell would be Slow and frustrating. 
· If the spreadsheet author has enabled Freeze panes, there are pros and cons related to disabling them. Unless you have some usable vision, freezing panes may be of limited value to you. If you want to be able to press Control Home to get to cell A1, which could make navigating this spreadsheet more straightforward in some cases, disable Freeze panes by pressing Alt W F and unchecking it here. That said, the most logical place for the spreadsheet author to set Freeze panes is the cell containing the top left cell with data values, situated just to the right of its corresponding row header, and just below its corresponding column header. If this is indeed the case, keeping Freeze panes enabled and pressing Control Home will quickly get you to that top left data cell. 
· Hiding columns: Because this is a spreadsheet that is presumably updated and distributed on a monthly basis, you might only be interested in examining financial data for the most recent month. But because the author has inserted empty columns between each data column, navigating to the far right side of the spreadsheet is tedious. To render this more efficient, you can hide the columns not of immediate interest to you. That way, it will be much quicker to get to the columns that you want to examine. In this spreadsheet, you may only be interested in viewing the February 2020 and totals columns (columns Q and S). If so, you can hide columns C through P. See Chapter 5.9.1 on how to do this. 
· Assigning monitor cells with JAWS: You might find that certain cells are especially important. For example, cells S33, S130, and S132 present totals for income, expenses, and net income, respectively. Assigning monitor cells to each of these will enable you to navigate to them quickly. See Chapter 5.9.4 about how to assign monitor cells with JAWS and navigate to them. 
Adding comments: If you assign monitor cells to each of the three cells just mentioned, this is useful for navigation purposes, but you may not remember what the data in these cells refer to. You can add comments to each of them to remind you (Chapter 5.9.2).


